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o FontWorks - Basic Lettering 

If you are looking for more fonts for your embroidery projects and you want fonts 
that will work every time, then you may want to try the professionally digitized 
fonts that are included in FontWorks.  Creating and editing letting in FontWorks is 
quick and easy and the lettering sews out beautifully 
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Set up 
1. Some of the icons you will use most frequently are on the Quick Access 

tool bar 
2. The Quick Access tool bar can be moved 

• The default position of the tool bar is at the upper left corner of the 
page as shown in the picture on the left.  

• If you would prefer to have the Quick Access tool bar closer to the 
design page, left click on the black arrow at the right end of the tool 

bar and select Show Below the Ribbon  
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There four icons in the Display section of the ribbon control what you see as you 
create lettering

 

1. Draw 3D   

• Left click Draw 3D if you want to see the lettering as it will look 
when it is stitched 

2. Grid  

• The Grid icon will show or hide the background grid 

3. Hoop  

• Use the Hoop icon to display the outline of the hoop on the design 
page. 

•  

• Left click the black arrow on the 

Hoop icon  and Select Hoop 

 to display the 
Hoops box  

4. At the top of the box you will find a 
window that can be opened to select the 
stitch format you will be using 

• The list of hoops changes to show the hoop sizes available in 
your format 
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5. If you are using a Multi Needle embroidery machine, place a checkmark in 

the Multi Needle box  in the upper right corner of the Hoops 
box 

• The list changes to show the hoops available for the multi-
needle machines 

6. Left click the desired hoop in the list 

7. Left click Apply  and the hoop is placed on the design page, but 
the Hoops box remains open 

• If you left click Close the box closes without changing the hoop 
displayed on the design page 

8. If you want to turn the hoop on its side for design purposes, place a 

checkmark in the Rotate 90  box in the lower right corner of the 
box 

9. Left click OK  and the Hoops box is closed and the hoop on the 
design page is changed 

10. Left click the black arrow on the Background icon  
and you will be given a choice to choose a color or a fabric 
for the background on the design page 

11. Left click to select the Fabric option and the folder with fabric 
images opens 

• Some 
fabric 
images are 
included in 
FontWorks 

• And there 
are 
additional 
fabric 
images in 
the Applique 
fabric folder 

• Select 
one of the included fabrics 

• Or you can scan your own fabric and save it to the folder so it 
can be used as a background 

12. Left click on the color option and a box opens to allow you to select a 
color for the background of the design page 

• Select one of the color chips on the left 

• Or select from the spectrum on the right 
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o Left click Add to Custom Colors 

 to create a color chip on the 
right that can be selected 

13. The sample was created using a white background and the 180mm x 
300mm hoop (7” x 12”) for the Unity 

Create Text 

1. Left click the Text Tool  on the ribbon. 
2. Left click on the design page.  
3. Letters saying “MY TEXT” are placed on the page. 

• If the satin stitch warning is displayed, just left click OK  
to close the warning box.   

o We will be changing fonts anyway. 

• The font used will be the last font you 
selected and used. 

• Even if your FontWorks has been closed, 
the program remembers what font you 
were using last time. 

4. The Properties box opens on the right side of the 
page. 

5. To select a font, click on the down arrow at the 
right of the Font box to open the font list 

6. Scroll through the font list. 

• As you scroll through the list a preview of 
each font is shown in a large grey box to 
the left of the font list.  

7. Select the font called Lazy Days and left click Apply  
8. The lettering on the design page still says MY TEXT, but the style of the 

letters is changed to the selected font. 

Font Information 
One of the best things about the FontWorks program is 
the amount of information available on each font.  You 
can know what characters are available, and what the 
recommended size range for those letters is before you 
spend a lot of time trying to make the font work. 
 

1. To get more information about the font left click 

on the question mark  to the right of the font 
window. 
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2. The Font Information box opens and displays: 

• The characters available in the selected font 
o Lazy Days has upper case letters, lower case letters, 

numbers, lots of punctuation marks and even has the foreign 
letters in both upper and lower case 

• The recommended minimum and maximum sizes for the font 
o Lazy Days is an outline font, so size ranges are shown for 

the font stitched with a satin outline stitch, a run or straight 
stitch outline, and for the more traditional satin stitched 
letters. 

3. Click OK  to close Lazy Days Font Information box. 
4. It is also possible to open the view the same information box by placing 

your cursor over the white preview window at the left of the Font list. 
o When you open the box by 

placing your mouse over 
the white preview window, 
it will only stay open as 
long as your cursor is over 
the preview window.   

o When you move your 
cursor, the box will close.  

o This way of viewing the 
Font properties is great if 
you just need a quick peek 
at the information 

Type Your Text 
1. Type what you want your lettering to say in the Properties box. 

• Left click and drag across MY TEXT in the Properties box to select 
the text 

• Type: 
o “Whoever 

said” and 
touch Enter on 
your keyboard 

o “Diamonds” 
and touch 
Enter on your 
keyboard 

o “are a girl’s 
best friend” 
and touch 
Enter on your keyboard 
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o Never had a pug  

2. Left click Apply  
and the lettering on the design 
page changes  
3. When typing in Properties, you 
should always type exactly the way 
you want it to look when it is 
stitched. 

• Use the same upper or 
lower-case letters that will be stitched. 

• Type any numbers or punctuation that should be stitched. 

• Touching Enter on the keyboard will move down to the next line. 

• You can create as many lines of text as you can fit into your 
hoop. 

Add an Embroidery Design 
It is easy to add an embroidery design. 

1. Left click Merge Design  on the Quick Access tool bar. 
2. Navigate to the folder where your design is stored. 

3. Select the pattern and left click Open  to place the pattern on 
the design page. 

 
Position the embroidery design and the letters as you want them in the hoop 

1. Left click on the stitching in the lettering to select the text. 
2. Left click and drag to move the letters 
3. Left click on the stitching in your embroidery design to select that pattern 
4. Left click and drag to move the design 
5. Left click Zoom to Fit 

 
in the Zoom section of he 
ribbon to zoom in so the hoop 
fills the design page Missing 
Letters 
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Missing Letters 
It is important to note, not all fonts have all characters.  If you do not check to see 
what characters are available before you type your text, you may sometimes be 
surprised. 

1. If the text is not selected and displaying the editing controls, left click the 

text and then left click on the Text tool  that was used to create the 
lettering 

2. Open the font list, scroll to the top of the list, and select 2 Color 
Recreation.  

3. Left click Apply  
4. The only letters created are the upper-case letters.  

5. If you click on the question mark  you will see that this font does not 
include lower case letters.  

6. The program gave us all of the letters available in the selected font. 

7. Left click OK  to close the Font Information box 
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8. Left click on Undo  on the Quick Access tool bar to return to the 
previous font. 

 

Align Text 
Editing your letters to get exactly the size and look that you need is easy.  

1. Some of your editing is controlled in the Properties box  
2. And some is controlled by using the click and drag control points displayed 

on the lettering.  
3. And some editing can be done in both places. 

 
If the text editing controls are no longer available on your text, it is easy to bring 
them back up. 

1. Left click on the stitching in any of your letters to select the text. 

2. Left click on the Text tool  that was used to create the lettering and 
the text editing controls will be displayed.  

 
Now you are ready to use the editing controls to create the exact look you want.  

1. Any time you have more than one line of text, you can select Center, Left, 
or Right to control how the lettering will be arranged. 

2. Left click to open the Align window 

• The Align box is used to line up multiple 
lines of text, and it is currently set to 
Center. 

• Each line of our lettering is centered 
under the line above it 
automatically. 

3. Open the Align list by clicking on the down 
arrow and select Left. 

4. Left click Apply   
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• The lettering moves so that all lines of the text are lined up along the 
left side. 

Slant Text 
Use the Slant settings to tilt the letters and create a new look. 

1. Slant tilts the letters to either the left or the right 

• Tilt the letters to the right to create the look of an italic font. 

• Or tilt the letters to the left so they look like they were written left 
handed. 

2. There are two ways to change the Slant setting 

• Change the number in the Slant box in 
the Properties box 

• Or click and drag the black diamond  
at the lower left corner of the text on the 
design page 

3. To change the slant setting in the 
Properties box, click and drag across the 
number in the Slant box to highlight it. 

4. Type in the number 12 

5. Click Apply   

• The letters all tilt to the right like an italic font.  

 
6. You can also 

change the 
slant by 
clicking and 
dragging on 
the black 

diamond  at 
the lower left 
corner of the 
letters on the 
design page. 
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7. Drag the diamond  to the left to lean the letters left so they look like they 
were written left handed.  

• As you click and drag the black control point  and you will see the 
wire frame of the letters that shows the angle of the letters  

• When you let go of the left mouse button, the stitching will change to 
match the position of the frame. 

8. The new setting will be shown in the Slant box in the Properties box. 

• The new setting is a minus number because the letters were tilted to 
the left . 

Text Height 
Changing the Height of the letters also changes the size of those letters.  

1. The font can be re-sized to fit your needs.   
2. It will be automatically re-digitized and the 

stitch count will be adjusted when you re-
size your fonts. 

3. Changing the Height of the letters changes 
the size of the letters because fonts are 
sized based on their height. 

 
The measurement system you selected will be 
used to show the size of your fonts. 

1. To select either millimeters or inches: 

• Left click the Preferences tab 

 

• Left click Preferences  on the ribbon 
2. The Preferences box opens 

• Select the Environment tab  

• Left click to open the Units window 

• Select either English for inches 
or Metric for millimeters 

• Left click OK to close the 
Preferences box  

3. The selected measuring system will be 
used to show the Height of the letters 
in the Properties box 

4. Left click to return to the Home tab 
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There are two different ways you can adjust the size of your letters 

1. The Height can be adjusted in the Height box in Properties 
2. Or you can adjust the Height by clicking and dragging the black control 

point  at the upper left corner of the lettering on the design page. 
3. To change the Height of your letters in the Properties box, left click and 

drag across the numbers in the Height box to highlight them 

4. Set the size to 1.0 inches and left click Apply   

• The letters do not just get taller, they also get larger. 
5. You can also change the Height of the letters by clicking and dragging on 

the black control point  at the upper left corner of the lettering on the 
design page.  

6. Click and drag the black control point  
and you will see the wire frame of the 
letters, so you can see how big your font 
will be. 

7. When you let go of the left mouse button, 
the stitching will change to match the size 
of the frame. 

8. The new height is shown in the Height box 
in the Properties box.  

Text Width 
Changing the Width of your letters will not affect the height of the text.   

1. So, you can keep the size of the letters the same while making those 
same letters wider or narrower. 

2. There are two different ways you can adjust the Width of your letters 

• The Width can be adjusted in the Width box in Properties 

• Or you can adjust the Width by clicking and dragging the black 

control point  at the lower right corner of the lettering on the 
design page. 

3. The default setting for the width in the Properties box is 100%. 
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• Setting the width at a number higher than 100 will make the letters 
wider. 

4. Left click and drag across the 100 in the Width box to highlight it. 

5. Change the width to 150 and click Apply   

• The letters are wider, but the height does not change. 
6. Setting the width at a number lower than 100 will make the letters 

narrower. 
7. Left click and drag across the numbers in the Width box to highlight them 

8. Change the width to 75 and click Apply  

• The letters are all narrower, but the height remains the same.  

9. You can also click and drag the black control point  at the lower right to 
change the width of the letters. 

• Drag the black control point  to the right to make the letters 
wider. 

• Drag the black control point  to the left to make the letters 
narrower. 
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• The frame of the letters will be visible as you click and drag the 
control point, and as it does with the other click and drag controls, 
the stitches will fill the frame when you release the mouse button.  

10. The new setting for the width of the letters will be shown in the Width box 
in the Properties box.  

Text Spacing 
Spacing changes the space between all of the letters.   

1. If your font looks too crowded, you can add space between the letters.  
2. If the font looks too spread out, you can use a minus number on Spacing 

to move all the letters 
closer together. 

3. To change the spacing 
between the letters, left 
click and drag across 
the zero in the Spacing 
box to highlight it. 

4. Type 3 in the Spacing 
box and click Apply 

 
• The letters are 

moved so there is more space between them  
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5. If you want to move the letters closer together you will need to type a 
negative number in the Spacing box. 

6. Left click and drag across the numbers in the Spacing box to highlight 
them 

7. Type -2 and click Apply   
8. The letters are moved closer together. 

9. When new lettering is created the default setting for Spacing is 0. 
10. To return to the original spacing, change the Spacing to 0 and click Apply 

  

Line Spacing 
Line Spacing is used when you have more than one line of text.  

1. Line Spacing is used to control the amount of space between the lines. 
2. The default setting is for the space between lines to be 25% of the height 

of the letters. 

• So, if the letters were 1 inch tall, the space between lines would be 
¼ inch. 

3. If you want less space between the lines, change to a lower percentage. 
4. Left click and drag across the 25 in the Line Spacing box to highlight it. 

5. Type 11 and left click Apply   
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• The lines of text move closer together  

6. If you want more space between the lines, change to a higher percentage. 
7. Left click and drag across the 11 in the Line Spacing box to highlight it. 

8. Type 37 and left click Apply  

• And the lines of text are moved farther apart.   

Adjust the Space Between Letters 
The blue diamonds  are used to adjust the space between individual letters.  

1. Each letter has a blue diamond  at the left side of the letter except the 
first letter in each line.   

• The first letter in each line does not have a 
blue diamond because there is nothing to 
the left of that letter that you could move 
closer to or farther away from. 

2. The spacing of the letters in the word “pug” is not 
quite right  

3. Click and drag the blue diamond  for the letter “u” to the left to move 
closer to the letter “p”. 

• You will see the wire frame for the letter “u” as it is being moved.   

• All letters that follow the letter being moved are also moved so the 
spacing in those letters is not distorted. 
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• You will never have to go through and adjust all the rest of the 
letters because you needed to change the spacing between two 
specific letters! 

4. Left click and drag to move the letter “g” slightly to 
the right 

• You can adjust the space between any of the 
letters as needed, so everything looks just 
right.  

Edit Individual Letters 
It is easy to move, rotate, or re-size the individual letters.  The gold box on each 
letter allows the letter to be selected and edited.   

1. Left click on the gold box  on the letter “D” in Diamonds.  

• Only the letter “D” will be selected. 

2. You can move it by clicking and dragging the gold box   

• Unlike many lettering programs, the letters are not tied to a base 
line.   

• The letter can be moved anywhere in the hoop.  

3. Use the small green boxes on the upper left or lower right corners of the 
selection box around the letter to resize the “D” and make it larger. 
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• Simply click and drag 
the small green box 
to change the size of 
the letter 

• The size of the other 
letters is not affected   

4. Use the small green dots on 
the upper right or lower left 
corners of the selection box 
around the letter “S” to 
rotate the letter. 

• Click and drag the small green dot to rotate the letter 

• The rotation of the other letters is not affected  

5. Left click Undo  on the Quick Access tool bar until the letter “D” 
returns to its original size and position 

 
NOTE that the blue diamonds and the gold squares which are inside the dotted 
line should be edited last after you have changed the control points outside the 

dotted line.  Controls outside the dotted line affect all of the letters and will re-set 
any editing you have done to individual letters. Controls inside the dotted line 
affect individual letters and should be used last.  

Change Text Color 
This is truly custom lettering and the only thing left to 
do is to use the thread search to match the color of the 
lettering to the color of the pug’s sweater. 

1. The color of the sweater is shown in the 
Sequence View so the color we need to find is 
#1160 

2. Left click the Thread Search icon  at the 
left end of the color bar 
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3. Type 1160 in the search window 

4. Left click Find  
5. The color requested is the first color on the left end of the color bar 
6. Left click the color chip to change the color of the text 

 Saving Your Design 
There are two different types of files which should be saved when you create a 
design in FontWorks.   

1. The .BLF file is the editing file used by FontWorks  
2. The .BLF file will allow you to re-edit the text without having to start from 

scratch.  
3. And you will also need to save the stitch file in the format that your 

machine reads. 

4. Left click the File icon  in the upper left corner of the page 

5. Scroll down and left click Save As  in the File menu 
6. A Save As box opens 

• The Save in: window shows what folder the pattern will be stored 
in. 

o If necessary, open this window and navigate to the folder 
where you want to store this pattern 
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• Give your pattern a name 

• The Save as type: window shows what the file extension will be.  
o The first time you save the design, you should save it with 

the .BLF file extension that is the working file in FontWorks. 

7. Left click Save   
8. Repeat the process to save the stitch file for your machine. 

9. Left click the File icon  in the upper left corner of the page 

10. Scroll down and left click Save As  in the File menu 
11. The Save As box opens 

• The Stitch file can be saved in the same folder with the .BLF file, so 
the folder shown in the Save in window may not need to be 
changed. 

• You can also use the same name for both of the files, so this does 
not need to be changed either 

• You will need to open the Save as type: window to find the stitch 
format that your machine saves. 

• Left click on your format to select it. 

12.  Left click Save   
 


